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Understanding Embedded - FPGAs (Field
Programmable Gate Array)

Embedded - FPGAs, or Field Programmable Gate Arrays,
are advanced integrated circuits that offer unparalleled
flexibility and performance for digital systems. Unlike
traditional fixed-function logic devices, FPGAs can be
programmed and reprogrammed to execute a wide array
of logical operations, enabling customized functionality
tailored to specific applications. This reprogrammability
allows developers to iterate designs quickly and implement
complex functions without the need for custom hardware.

Applications of Embedded - FPGAs

The versatility of Embedded - FPGAs makes them
indispensable in numerous fields. In telecommunications,
FPGAs are used for high-speed data processing and
network infrastructure. In the automotive industry, they
support advanced driver-assistance systems (ADAS) and
infotainment solutions. Consumer electronics benefit from
FPGAs in devices requiring high performance and
adaptability, such as smart TVs and gaming consoles.
Industrial automation relies on FPGAs for real-time control
and processing in machinery and robotics. Additionally,
FPGAs play a crucial role in aerospace and defense, where
their reliability and ability to handle complex algorithms
are essential.

Common Subcategories of Embedded -
FPGAs

Within the realm of Embedded - FPGAs, several
subcategories address different needs and applications.
General-purpose FPGAs are the most widely used, offering
a balance of performance and flexibility for a broad range
of applications. High-performance FPGAs are designed for
applications requiring exceptional speed and
computational power, such as data centers and high-
frequency trading systems. Low-power FPGAs cater to
battery-operated and portable devices where energy
efficiency is paramount. Lastly, automotive-grade FPGAs
meet the stringent standards of the automotive industry,
ensuring reliability and performance in vehicle systems.

Types of Embedded - FPGAs

Embedded - FPGAs can be classified into several types
based on their architecture and specific capabilities. SRAM-
based FPGAs are prevalent due to their high speed and
ability to support complex designs, making them suitable
for performance-critical applications. Flash-based FPGAs
offer non-volatile storage, retaining their configuration
without power and enabling faster start-up times. Antifuse-
based FPGAs provide a permanent, one-time
programmable solution, ensuring robust security and
reliability for critical systems. Each type of FPGA brings
distinct advantages, making the choice dependent on the
specific needs of the application.

Details

Product Status Active

Number of LABs/CLBs 8375

Number of Logic Elements/Cells 67000

Total RAM Bits 4526080

Number of I/O 380

Number of Gates -

Voltage - Supply 1.14V ~ 1.26V

Mounting Type Surface Mount

Operating Temperature -40°C ~ 100°C (TJ)

Package / Case 672-BBGA

Supplier Device Package 672-FPBGA (27x27)
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Features
 Higher Logic Density for Increased System 

Integration
• 17K to 149K LUTs
• 116 to 586 I/Os

 Embedded SERDES 
• 150 Mbps to 3.2 Gbps for Generic 8b10b, 10-bit 

SERDES, and 8-bit SERDES modes
• Data Rates 230 Mbps to 3.2 Gbps per channel 

for all other protocols
• Up to 16 channels per device: PCI Express, 

SONET/SDH, Ethernet (1GbE, SGMII, XAUI), 
CPRI, SMPTE 3G and Serial RapidIO

 sysDSP™
• Fully cascadable slice architecture
• 12 to 160 slices for high performance multiply 

and accumulate
• Powerful 54-bit ALU operations
• Time Division Multiplexing MAC Sharing
• Rounding and truncation
• Each slice supports

— Half 36x36, two 18x18 or four 9x9 multipliers
— Advanced 18x36 MAC and 18x18 Multiply-

Multiply-Accumulate (MMAC) operations
 Flexible Memory Resources

• Up to 6.85Mbits sysMEM™ Embedded Block 
RAM (EBR) 

• 36K to 303K bits distributed RAM
 sysCLOCK Analog PLLs and DLLs

• Two DLLs and up to ten PLLs per device
 Pre-Engineered Source Synchronous I/O

• DDR registers in I/O cells

• Dedicated read/write levelling functionality
• Dedicated gearing logic
• Source synchronous standards support

— ADC/DAC, 7:1 LVDS, XGMII
— High Speed ADC/DAC devices

• Dedicated DDR/DDR2/DDR3 memory with DQS 
support

• Optional Inter-Symbol Interference (ISI) 
correction on outputs

 Programmable sysI/O™ Buffer Supports 
Wide Range of Interfaces

• On-chip termination
• Optional equalization filter on inputs
• LVTTL and LVCMOS 33/25/18/15/12
• SSTL 33/25/18/15 I, II
• HSTL15 I and HSTL18 I, II
• PCI and Differential HSTL, SSTL
• LVDS, Bus-LVDS, LVPECL, RSDS, MLVDS

 Flexible Device Configuration 
• Dedicated bank for configuration I/Os
• SPI boot flash interface
• Dual-boot images supported
• Slave SPI
• TransFR™ I/O for simple field updates
• Soft Error Detect embedded macro

 System Level Support
• IEEE 1149.1 and IEEE 1532 compliant
• Reveal Logic Analyzer
• ORCAstra FPGA configuration utility
• On-chip oscillator for initialization & general use
• 1.2 V core power supply

Table 1-1. LatticeECP3™ Family Selection Guide
Device ECP3-17 ECP3-35 ECP3-70 ECP3-95 ECP3-150

LUTs (K) 17 33 67 92 149
sysMEM Blocks (18 Kbits) 38 72 240 240 372
Embedded Memory (Kbits) 700 1327 4420 4420 6850
Distributed RAM Bits (Kbits) 36 68 145 188 303
18 x 18 Multipliers 24 64 128 128 320
SERDES (Quad) 1 1 3 3 4
PLLs/DLLs 2 / 2 4 / 2 10 / 2 10 / 2 10 / 2
Packages and SERDES Channels/ I/O Combinations
328 csBGA (10 x 10 mm) 2 / 116
256 ftBGA (17 x 17 mm) 4 / 133 4 / 133   
484 fpBGA (23 x 23 mm) 4 / 222 4 / 295 4 / 295 4 / 295  
672 fpBGA (27 x 27 mm) 4 / 310 8 / 380 8 / 380 8 / 380
1156 fpBGA (35 x 35 mm)   12 / 490 12 / 490 16 / 586

LatticeECP3 Family Data Sheet
Introduction
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This allows designers to use highly parallel implementations of DSP functions. Designers can optimize DSP perfor-
mance vs. area by choosing appropriate levels of parallelism. Figure 2-23 compares the fully serial implementation 
to the mixed parallel and serial implementation. 

Figure 2-23. Comparison of General DSP and LatticeECP3 Approaches

LatticeECP3 sysDSP Slice Architecture Features
The LatticeECP3 sysDSP Slice has been significantly enhanced to provide functions needed for advanced pro-
cessing applications. These enhancements provide improved flexibility and resource utilization.

The LatticeECP3 sysDSP Slice supports many functions that include the following:

• Multiply (one 18 x 36, two 18 x 18 or four 9 x 9 Multiplies per Slice)

• Multiply (36 x 36 by cascading across two sysDSP slices)

• Multiply Accumulate (up to 18 x 36 Multipliers feeding an Accumulator that can have up to 54-bit resolution)

• Two Multiplies feeding one Accumulate per cycle for increased processing with lower latency (two 18 x 18 Mul-
tiplies feed into an accumulator that can accumulate up to 52 bits)

• Flexible saturation and rounding options to satisfy a diverse set of applications situations

• Flexible cascading across DSP slices
—  Minimizes fabric use for common DSP and ALU functions
—  Enables implementation of FIR Filter or similar structures using dedicated sysDSP slice resources only
—  Provides matching pipeline registers
—  Can be configured to continue cascading from one row of sysDSP slices to another for longer cascade 

chains

• Flexible and Powerful Arithmetic Logic Unit (ALU) Supports:
—  Dynamically selectable ALU OPCODE
—  Ternary arithmetic (addition/subtraction of three inputs)
—  Bit-wise two-input logic operations (AND, OR, NAND, NOR, XOR and XNOR)
—  Eight flexible and programmable ALU flags that can be used for multiple pattern detection scenarios, such 
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as, overflow, underflow and convergent rounding, etc.
—  Flexible cascading across slices to get larger functions

• RTL Synthesis friendly synchronous reset on all registers, while still supporting asynchronous reset for legacy 
users

• Dynamic MUX selection to allow Time Division Multiplexing (TDM) of resources for applications that require 
processor-like flexibility that enables different functions for each clock cycle

For most cases, as shown in Figure 2-24, the LatticeECP3 DSP slice is backwards-compatible with the 
LatticeECP2™ sysDSP block, such that, legacy applications can be targeted to the LatticeECP3 sysDSP slice. The 
functionality of one LatticeECP2 sysDSP Block can be mapped into two adjacent LatticeECP3 sysDSP slices, as 
shown in Figure 2-25.

Figure 2-24. Simplified sysDSP Slice Block Diagram
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MMAC DSP Element
The LatticeECP3 supports a MAC with two multipliers. This is called Multiply Multiply Accumulate or MMAC. In this 
case, the two operands, AA and AB, are multiplied and the result is added with the previous accumulated value and 
with the result of the multiplier operation of operands BA and BB. This accumulated value is available at the output. 
The user can enable the input and pipeline registers, but the output register is always enabled. The output register 
is used to store the accumulated value. The ALU is configured as the accumulator in the sysDSP slice. A registered 
overflow signal is also available. The overflow conditions are provided later in this document. Figure 2-28 shows the 
MMAC sysDSP element. 

Figure 2-28. MMAC sysDSP Element
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Figure 2-34. Output and Tristate Block for Left and Right Edges

Tristate Register Block 
The tristate register block registers tri-state control signals from the core of the device before they are passed to the 
sysI/O buffers. The block contains a register for SDR operation and an additional register for DDR operation.

In SDR and non-gearing DDR modes, TS input feeds one of the flip-flops that then feeds the output. In DDRX2 
mode, the register TS input is fed into another register that is clocked using the DQCLK0 and DQCLK1 signals. The 
output of this register is used as a tristate control.

ISI Calibration
The setting for Inter-Symbol Interference (ISI) cancellation occurs in the output register block. ISI correction is only 
available in the DDRX2 modes. ISI calibration settings exist once per output register block, so each I/O in a DQS-
12 group may have a different ISI calibration setting.

The ISI block extends output signals at certain times, as a function of recent signal history. So, if the output pattern 
consists of a long strings of 0's to long strings of 1's, there are no delays on output signals. However, if there are 
quick, successive transitions from 010, the block will stretch out the binary 1. This is because the long trail of 0's will 
cause these symbols to interfere with the logic 1. Likewise, if there are quick, successive transitions from 101, the 
block will stretch out the binary 0. This block is controlled by a 3-bit delay control that can be set in the DQS control 
logic block. 

For more information about this topic, please see the list of technical documentation at the end of this data sheet.
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Figure 2-37. DQS Local Bus

Polarity Control Logic
In a typical DDR Memory interface design, the phase relationship between the incoming delayed DQS strobe and 
the internal system clock (during the READ cycle) is unknown. The LatticeECP3 family contains dedicated circuits 
to transfer data between these domains. A clock polarity selector is used to prevent set-up and hold violations at 
the domain transfer between DQS (delayed) and the system clock. This changes the edge on which the data is reg-
istered in the synchronizing registers in the input register block. This requires evaluation at the start of each READ 
cycle for the correct clock polarity. 

Prior to the READ operation in DDR memories, DQS is in tristate (pulled by termination). The DDR memory device 
drives DQS low at the start of the preamble state. A dedicated circuit detects the first DQS rising edge after the pre-
amble state. This signal is used to control the polarity of the clock to the synchronizing registers.

DDR3 Memory Support
LatticeECP3 supports the read and write leveling required for DDR3 memory interfaces.

Read leveling is supported by the use of the DDRCLKPOL and the DDRLAT signals generated in the DQS Read 
Control logic block. These signals dynamically control the capture of the data with respect to the DQS at the input 
register block. 
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Figure 2-38. LatticeECP3 Banks

LatticeECP3 devices contain two types of sysI/O buffer pairs. 

1. Top (Bank 0 and Bank 1) and Bottom sysIO Buffer Pairs (Single-Ended Outputs Only)
The sysI/O buffer pairs in the top banks of the device consist of two single-ended output drivers and two sets of 
single-ended input buffers (both ratioed and referenced). One of the referenced input buffers can also be con-
figured as a differential input. Only the top edge buffers have a programmable PCI clamp.

The two pads in the pair are described as “true” and “comp”, where the true pad is associated with the positive 
side of the differential input buffer and the comp (complementary) pad is associated with the negative side of 
the differential input buffer. 

The top and bottom sides are ideal for general purpose I/O, PCI, and inputs for LVDS (LVDS outputs are only 
allowed on the left and right sides). The top side can be used for the DDR3 ADDR/CMD signals. 

The I/O pins located on the top and bottom sides of the device (labeled PTxxA/B or PBxxA/B) are fully hot 
socketable. Note that the pads in Banks 3, 6 and 8 are wrapped around the corner of the device. In these 
banks, only the pads located on the top or bottom of the device are hot socketable. The top and bottom side 
pads can be identified by the Lattice Diamond tool.
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2. Left and Right (Banks 2, 3, 6 and 7) sysI/O Buffer Pairs (50% Differential and 100% Single-Ended Out-
puts)
The sysI/O buffer pairs in the left and right banks of the device consist of two single-ended output drivers, two 
sets of single-ended input buffers (both ratioed and referenced) and one differential output driver. One of the 
referenced input buffers can also be configured as a differential input. In these banks the two pads in the pair 
are described as “true” and “comp”, where the true pad is associated with the positive side of the differential I/O, 
and the comp (complementary) pad is associated with the negative side of the differential I/O. 

In addition, programmable on-chip input termination (parallel or differential, static or dynamic) is supported on 
these sides, which is required for DDR3 interface. However, there is no support for hot-socketing for the I/O 
pins located on the left and right side of the device as the PCI clamp is always enabled on these pins.

LVDS, RSDS, PPLVDS and Mini-LVDS differential output drivers are available on 50% of the buffer pairs on the 
left and right banks. 

3. Configuration Bank sysI/O Buffer Pairs (Single-Ended Outputs, Only on Shared Pins When Not Used by 
Configuration)
The sysI/O buffers in the Configuration Bank consist of ratioed single-ended output drivers and single-ended 
input buffers. This bank does not support PCI clamp like the other banks on the top, left, and right sides. 

The two pads in the pair are described as “true” and “comp”, where the true pad is associated with the positive 
side of the differential input buffer and the comp (complementary) pad is associated with the negative side of 
the differential input buffer. 

Programmable PCI clamps are only available on the top banks. PCI clamps are used primarily on inputs and bi-
directional pads to reduce ringing on the receiving end.

Typical sysI/O I/O Behavior During Power-up 
The internal power-on-reset (POR) signal is deactivated when VCC, VCCIO8 and VCCAUX have reached satisfactory 
levels. After the POR signal is deactivated, the FPGA core logic becomes active. It is the user’s responsibility to 
ensure that all other VCCIO banks are active with valid input logic levels to properly control the output logic states of 
all the I/O banks that are critical to the application. For more information about controlling the output logic state with 
valid input logic levels during power-up in LatticeECP3 devices, see the list of technical documentation at the end 
of this data sheet. 

The VCC and VCCAUX supply the power to the FPGA core fabric, whereas the VCCIO supplies power to the I/O buf-
fers. In order to simplify system design while providing consistent and predictable I/O behavior, it is recommended 
that the I/O buffers be powered-up prior to the FPGA core fabric. VCCIO supplies should be powered-up before or 
together with the VCC and VCCAUX supplies. 

Supported sysI/O Standards 
The LatticeECP3 sysI/O buffer supports both single-ended and differential standards. Single-ended standards can 
be further subdivided into LVCMOS, LVTTL and other standards. The buffers support the LVTTL, LVCMOS 1.2 V, 
1.5 V, 1.8 V, 2.5 V and 3.3 V standards. In the LVCMOS and LVTTL modes, the buffer has individual configuration 
options for drive strength, slew rates, bus maintenance (weak pull-up, weak pull-down, or a bus-keeper latch) and 
open drain. Other single-ended standards supported include SSTL and HSTL. Differential standards supported 
include LVDS, BLVDS, LVPECL, MLVDS, RSDS, Mini-LVDS, PPLVDS (point-to-point LVDS), TRLVDS (Transition 
Reduced LVDS), differential SSTL and differential HSTL. For further information on utilizing the sysI/O buffer to 
support a variety of standards please see TN1177, LatticeECP3 sysIO Usage Guide. 

www.latticesemi.com/dynamic/view_document.cfm?document_id=32317
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, 2Derating Timing Tables
Logic timing provided in the following sections of this data sheet and the Diamond and ispLEVER design tools are 
worst case numbers in the operating range. Actual delays at nominal temperature and voltage for best case pro-
cess, can be much better than the values given in the tables. The Diamond and ispLEVER design tools can provide 
logic timing numbers at a particular temperature and voltage.

18x18 Multiply/Accumulate (Input & Output Registers) 200 MHz

18x18 Multiply-Add/Sub (All Registers) 400 MHz

1. These timing numbers were generated using ispLEVER tool. Exact performance may vary with device and tool version. The tool uses inter-
nal parameters that have been characterized but are not tested on every device.

2. Commercial timing numbers are shown. Industrial numbers are typically slower and can be extracted from the Diamond or ispLEVER soft-
ware.

3. For details on -9 speed grade devices, please contact your Lattice Sales Representative.

Register-to-Register Performance1, 2, 3

 Function –8 Timing Units
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LatticeECP3 Family Timing Adders1, 2, 3, 4, 5, 7 
Over Recommended Commercial Operating Conditions

Buffer Type Description –8 –7 –6 Units

Input Adjusters 

LVDS25E LVDS, Emulated, VCCIO = 2.5 V 0.03 –0.01 –0.03 ns

LVDS25 LVDS, VCCIO = 2.5 V 0.03 0.00 –0.04 ns

BLVDS25 BLVDS, Emulated, VCCIO = 2.5 V 0.03 0.00 –0.04 ns

MLVDS25 MLVDS, Emulated, VCCIO = 2.5 V 0.03 0.00 –0.04 ns

RSDS25 RSDS, VCCIO = 2.5 V 0.03 –0.01 –0.03 ns

PPLVDS Point-to-Point LVDS 0.03 –0.01 –0.03 ns

TRLVDS Transition-Reduced LVDS 0.03 0.00 –0.04 ns

Mini MLVDS Mini LVDS 0.03 –0.01 –0.03 ns

LVPECL33 LVPECL, Emulated, VCCIO = 3.3 V 0.17 0.23 0.28 ns

HSTL18_I HSTL_18 class I, VCCIO = 1.8 V 0.20 0.17 0.13 ns

HSTL18_II HSTL_18 class II, VCCIO = 1.8 V 0.20 0.17 0.13 ns

HSTL18D_I Differential HSTL 18 class I 0.20 0.17 0.13 ns

HSTL18D_II Differential HSTL 18 class II 0.20 0.17 0.13 ns

HSTL15_I HSTL_15 class I, VCCIO = 1.5 V 0.10 0.12 0.13 ns

HSTL15D_I Differential HSTL 15 class I 0.10 0.12 0.13 ns

SSTL33_I SSTL_3 class I, VCCIO = 3.3 V 0.17 0.23 0.28 ns

SSTL33_II SSTL_3 class II, VCCIO = 3.3 V 0.17 0.23 0.28 ns

SSTL33D_I Differential SSTL_3 class I 0.17 0.23 0.28 ns

SSTL33D_II Differential SSTL_3 class II 0.17 0.23 0.28 ns

SSTL25_I SSTL_2 class I, VCCIO = 2.5 V 0.12 0.14 0.16 ns

SSTL25_II SSTL_2 class II, VCCIO = 2.5 V 0.12 0.14 0.16 ns

SSTL25D_I Differential SSTL_2 class I 0.12 0.14 0.16 ns

SSTL25D_II Differential SSTL_2 class II 0.12 0.14 0.16 ns

SSTL18_I SSTL_18 class I, VCCIO = 1.8 V 0.08 0.06 0.04 ns

SSTL18_II SSTL_18 class II, VCCIO = 1.8 V 0.08 0.06 0.04 ns

SSTL18D_I Differential SSTL_18 class I 0.08 0.06 0.04 ns

SSTL18D_II Differential SSTL_18 class II 0.08 0.06 0.04 ns

SSTL15 SSTL_15, VCCIO = 1.5 V 0.087 0.059 0.032 ns

SSTL15D Differential SSTL_15 0.087 0.059 0.032 ns

LVTTL33 LVTTL, VCCIO = 3.3 V 0.07 0.07 0.07 ns

LVCMOS33 LVCMOS, VCCIO = 3.3 V 0.07 0.07 0.07 ns

LVCMOS25 LVCMOS, VCCIO = 2.5 V 0.00 0.00 0.00 ns

LVCMOS18 LVCMOS, VCCIO = 1.8 V –0.13 –0.13 –0.13 ns

LVCMOS15 LVCMOS, VCCIO = 1.5 V –0.07 –0.07 –0.07 ns

LVCMOS12 LVCMOS, VCCIO = 1.2 V –0.20 –0.19 –0.19 ns

PCI33 PCI, VCCIO = 3.3 V 0.07 0.07 0.07 ns

Output Adjusters 

LVDS25E LVDS, Emulated, VCCIO = 2.5 V 1.02 1.14 1.26 ns

LVDS25 LVDS, VCCIO = 2.5 V –0.11 –0.07 –0.03 ns

BLVDS25 BLVDS, Emulated, VCCIO = 2.5 V 1.01 1.13 1.25 ns

MLVDS25 MLVDS, Emulated, VCCIO = 2.5 V 1.01 1.13 1.25 ns
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SERDES/PCS Block Latency
Table 3-8 describes the latency of each functional block in the transmitter and receiver. Latency is given in parallel 
clock cycles. Figure 3-12 shows the location of each block.

Table 3-8. SERDES/PCS Latency Breakdown

Figure 3-12. Transmitter and Receiver Latency Block Diagram

Item Description Min. Avg. Max. Fixed Bypass Units

Transmit Data Latency1

T1

FPGA Bridge - Gearing disabled with different clocks 1 3 5 — 1 word clk

FPGA Bridge - Gearing disabled with same clocks — — — 3 1 word clk

FPGA Bridge - Gearing enabled 1 3 5 — — word clk

T2 8b10b Encoder — — — 2 1 word clk

T3 SERDES Bridge transmit — — — 2 1 word clk

T4
Serializer: 8-bit mode — — — 15 + 1 — UI + ps

Serializer: 10-bit mode — — — 18 + 1 — UI + ps

T5
Pre-emphasis ON — — — 1 + 2 — UI + ps

Pre-emphasis OFF — — — 0 + 3 — UI + ps

Receive Data Latency2

R1
Equalization ON — — — 1 — UI + ps

Equalization OFF — — — 2 — UI + ps

R2
Deserializer: 8-bit mode — — — 10 + 3 — UI + ps

Deserializer: 10-bit mode — — — 12 + 3 — UI + ps

R3 SERDES Bridge receive — — — 2 — word clk

R4 Word alignment 3.1 — 4 — — word clk

R5 8b10b decoder — — — 1 — word clk

R6 Clock Tolerance Compensation 7 15 23 1 1 word clk

R7

FPGA Bridge - Gearing disabled with different clocks 1 3 5 — 1 word clk

FPGA Bridge - Gearing disabled with same clocks — — — 3 1 word clk

FPGA Bridge - Gearing enabled 1 3 5 — — word clk

1. 1 = –245 ps, 2 = +88 ps, 3 = +112 ps. 
2. 1 = +118 ps, 2 = +132 ps, 3 = +700 ps. 

HDOUTPi
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Adjust
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Serial Rapid I/O Type 2/CPRI LV E.24 Electrical and Timing Characteristics
AC and DC Characteristics
Table 3-15. Transmit

Table 3-16. Receive and Jitter Tolerance

Symbol Description Test Conditions Min. Typ. Max. Units

TRF
1 Differential rise/fall time 20%-80% — 80 — ps

ZTX_DIFF_DC Differential impedance 80 100 120 Ohms

JTX_DDJ
3, 4, 5 Output data deterministic jitter — — 0.17 UI

JTX_TJ
2, 3, 4, 5 Total output data jitter — — 0.35 UI

1. Rise and Fall times measured with board trace, connector and approximately 2.5pf load.
2. Total jitter includes both deterministic jitter and random jitter. The random jitter is the total jitter minus the actual deterministic jitter.
3. Jitter values are measured with each CML output AC coupled into a 50-Ohm impedance (100-Ohm differential impedance).
4. Jitter and skew are specified between differential crossings of the 50% threshold of the reference signal.
5. Values are measured at 2.5 Gbps.

Symbol Description Test Conditions Min. Typ. Max. Units

RLRX_DIFF Differential return loss From 100 MHz to 2.5 GHz 10 — — dB

RLRX_CM Common mode return loss From 100 MHz to 2.5 GHz 6 — — dB

ZRX_DIFF Differential termination resistance 80 100 120 Ohms

JRX_DJ
2, 3, 4, 5 Deterministic jitter tolerance (peak-to-peak) — — 0.37 UI

JRX_RJ
2, 3, 4, 5 Random jitter tolerance (peak-to-peak) — — 0.18 UI

JRX_SJ
2, 3, 4, 5 Sinusoidal jitter tolerance (peak-to-peak) — — 0.10 UI

JRX_TJ
1, 2, 3, 4, 5 Total jitter tolerance (peak-to-peak) — — 0.65 UI

TRX_EYE Receiver eye opening 0.35 — — UI

1. Total jitter includes deterministic jitter, random jitter and sinusoidal jitter. The sinusoidal jitter tolerance mask is shown in Figure 3-18.
2. Jitter values are measured with each high-speed input AC coupled into a 50-Ohm impedance.
3. Jitter and skew are specified between differential crossings of the 50% threshold of the reference signal.
4. Jitter tolerance, Differential Input Sensitivity and Receiver Eye Opening parameters are characterized when Full Rx Equalization is enabled.
5. Values are measured at 2.5 Gbps.
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Gigabit Ethernet/Serial Rapid I/O Type 1/SGMII/CPRI LV E.12 Electrical and 
Timing Characteristics
AC and DC Characteristics
Table 3-17. Transmit

Table 3-18. Receive and Jitter Tolerance

Symbol Description Test Conditions Min. Typ. Max. Units

TRF Differential rise/fall time 20%-80% — 80 — ps

ZTX_DIFF_DC Differential impedance 80 100 120 Ohms

JTX_DDJ
3, 4, 5 Output data deterministic jitter — — 0.10 UI

JTX_TJ
2, 3, 4, 5 Total output data jitter — — 0.24 UI

1. Rise and fall times measured with board trace, connector and approximately 2.5 pf load.
2. Total jitter includes both deterministic jitter and random jitter. The random jitter is the total jitter minus the actual deterministic jitter.
3. Jitter values are measured with each CML output AC coupled into a 50-Ohm impedance (100-Ohm differential impedance).
4. Jitter and skew are specified between differential crossings of the 50% threshold of the reference signal.
5. Values are measured at 1.25 Gbps.

Symbol Description Test Conditions Min. Typ. Max. Units

RLRX_DIFF Differential return loss From 100 MHz to 1.25 GHz 10 — — dB

RLRX_CM Common mode return loss From 100 MHz to 1.25 GHz 6 — — dB

ZRX_DIFF Differential termination resistance 80 100 120 Ohms

JRX_DJ
1, 2, 3, 4, 5 Deterministic jitter tolerance (peak-to-peak) — — 0.34 UI

JRX_RJ
1, 2, 3, 4, 5 Random jitter tolerance (peak-to-peak) — — 0.26 UI

JRX_SJ
1, 2, 3, 4, 5 Sinusoidal jitter tolerance (peak-to-peak) — — 0.11 UI

JRX_TJ
1, 2, 3, 4, 5 Total jitter tolerance (peak-to-peak) — — 0.71 UI

TRX_EYE Receiver eye opening 0.29 — — UI

1. Total jitter includes deterministic jitter, random jitter and sinusoidal jitter. The sinusoidal jitter tolerance mask is shown in Figure 3-18.
2. Jitter values are measured with each high-speed input AC coupled into a 50-Ohm impedance.
3. Jitter and skew are specified between differential crossings of the 50% threshold of the reference signal.
4. Jitter tolerance, Differential Input Sensitivity and Receiver Eye Opening parameters are characterized when Full Rx Equalization is enabled.
5. Values are measured at 1.25 Gbps.
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SMPTE SD/HD-SDI/3G-SDI (Serial Digital Interface) Electrical and Timing 
Characteristics
AC and DC Characteristics
Table 3-19. Transmit

Table 3-20. Receive

Table 3-21. Reference Clock

Symbol Description Test Conditions Min. Typ. Max. Units

BRSDO Serial data rate 270 — 2975 Mbps

TJALIGNMENT
 2 Serial output jitter, alignment 270 Mbps — — 0.20 UI

TJALIGNMENT
 2 Serial output jitter, alignment 1485 Mbps — — 0.20 UI

TJALIGNMENT
1, 2 Serial output jitter, alignment 2970Mbps — — 0.30 UI

TJTIMING Serial output jitter, timing 270 Mbps — — 0.20 UI

TJTIMING Serial output jitter, timing 1485 Mbps — — 1.0 UI

TJTIMING Serial output jitter, timing 2970 Mbps — — 2.0 UI

Notes:
1. Timing jitter is measured in accordance with SMPTE RP 184-1996, SMPTE RP 192-1996 and the applicable serial data transmission stan-

dard, SMPTE 259M-1997 or SMPTE 292M (proposed). A color bar test pattern is used.The value of fSCLK is 270 MHz or 360 MHz for 
SMPTE 259M, 540 MHz for SMPTE 344M or 1485 MHz for SMPTE 292M serial data rates. See the Timing Jitter Bandpass section.

2. Jitter is defined in accordance with SMPTE RP1 184-1996 as: jitter at an equipment output in the absence of input jitter.
3. All Tx jitter is measured at the output of an industry standard cable driver; connection to the cable driver is via a 50 Ohm impedance differ-

ential signal from the Lattice SERDES device.
4. The cable driver drives: RL=75 Ohm, AC-coupled at 270, 1485, or 2970 Mbps, RREFLVL=RREFPRE=4.75 kOhm 1%.

Symbol Description Test Conditions Min. Typ. Max. Units

BRSDI Serial input data rate 270 — 2970 Mbps

CID Stream of non-transitions 
(=Consecutive Identical Digits)

7(3G)/26(SMPTE 
Triple rates) 

@ 10-12 BER
— — Bits

Symbol Description Test Conditions Min. Typ. Max. Units

FVCLK Video output clock frequency 27 — 74.25 MHz

DCV Duty cycle, video clock 45 50 55 %
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JTAG Port Timing Specifications
Over Recommended Operating Conditions

Figure 3-32. JTAG Port Timing Waveforms

Symbol Parameter Min Max Units

fMAX TCK clock frequency — 25 MHz

tBTCP TCK [BSCAN] clock pulse width 40 — ns

tBTCPH TCK [BSCAN] clock pulse width high 20 — ns

tBTCPL TCK [BSCAN] clock pulse width low 20 — ns

tBTS TCK [BSCAN] setup time 10 — ns

tBTH TCK [BSCAN] hold time 8 — ns

tBTRF TCK [BSCAN] rise/fall time 50 — mV/ns

tBTCO TAP controller falling edge of clock to valid output — 10 ns

tBTCODIS TAP controller falling edge of clock to valid disable — 10 ns

tBTCOEN TAP controller falling edge of clock to valid enable — 10 ns

tBTCRS BSCAN test capture register setup time 8 — ns

tBTCRH BSCAN test capture register hold time 25 — ns

tBUTCO BSCAN test update register, falling edge of clock to valid output — 25 ns

tBTUODIS BSCAN test update register, falling edge of clock to valid disable — 25 ns

tBTUPOEN BSCAN test update register, falling edge of clock to valid enable — 25 ns

TMS

TDI

TCK

TDO

Data to be
captured
from I/O

Data to be
driven out

to I/O

ataD dilaVataD dilaV

ataD dilaVataD dilaV

Data Captured

tBTCPH tBTCPL

tBTCOEN

tBTCRS

tBTUPOEN tBUTCO tBTUODIS

tBTCRH

tBTCO tBTCODIS

tBTS tBTH

tBTCP
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sysI/O Differential Electrical Characteristics
Transition Reduced LVDS (TRLVDS DC Specification)

Over Recommended Operating Conditions

Mini LVDS
Over Recommended Operating Conditions

Symbol Description Min. Nom. Max. Units

VCCO Driver supply voltage (+/– 5%) 3.14 3.3 3.47 V

VID Input differential voltage 150 — 1200 mV

VICM Input common mode voltage 3 — 3.265 V

VCCO Termination supply voltage 3.14 3.3 3.47 V

RT Termination resistance (off-chip) 45 50 55 Ohms

Note: LatticeECP3 only supports the TRLVDS receiver.

Parameter Symbol Description Min. Typ. Max. Units

ZO Single-ended PCB trace impedance 30 50 75 Ohms

RT Differential termination resistance 50 100 150 Ohms

VOD Output voltage, differential, |VOP - VOM| 300 — 600 mV

VOS Output voltage, common mode, |VOP + VOM|/2 1 1.2 1.4 V

VOD Change in VOD, between H and L — — 50 mV

VID Change in VOS, between H and L — — 50 mV

VTHD Input voltage, differential, |VINP - VINM| 200 — 600 mV

VCM Input voltage, common mode, |VINP + VINM|/2 0.3+(VTHD/2) — 2.1-(VTHD/2)

TR, TF Output rise and fall times, 20% to 80% — — 550 ps

TODUTY Output clock duty cycle 40 — 60 %

Note: Data is for 6 mA differential current drive. Other differential driver current options are available.

Current 
Source

VCCO = 3.3 V

Z0

RT RTTransmitter

Receiver
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D7/SPID0 I/O Parallel configuration I/O. SPI/SPIm data input. Open drain during configura-
tion.

DI/CSSPI0N/CEN I/O Serial data input for slave serial mode. SPI/SPIm mode chip select. 

Dedicated SERDES Signals3

PCS[Index]_HDINNm I High-speed input, negative channel m 

PCS[Index]_HDOUTNm O High-speed output, negative channel m 

PCS[Index]_REFCLKN I Negative Reference Clock Input 

PCS[Index]_HDINPm I High-speed input, positive channel m 

PCS[Index]_HDOUTPm O High-speed output, positive channel m 

PCS[Index]_REFCLKP I Positive Reference Clock Input 

PCS[Index]_VCCOBm — Output buffer power supply, channel m (1.2V/1.5)

PCS[Index]_VCCIBm — Input buffer power supply, channel m (1.2V/1.5V) 

1. When placing switching I/Os around these critical pins that are designed to supply the device with the proper reference or supply voltage, 
care must be given. 

2. These pins are dedicated inputs or can be used as general purpose I/O.
3. m defines the associated channel in the quad. 

Signal Descriptions (Cont.)
Signal Name I/O Description 
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Pin Information Summary (Cont.)
Pin Information Summary ECP3-17EA ECP3-35EA

Pin Type 256 ftBGA 328 csBGA 484 fpBGA 256 ftBGA 484 fpBGA 672 fpBGA

Emulated Differential I/O per 
Bank

Bank 0 13 10 18 13 21 24

Bank 1 7 5 12 7 18 18

Bank 2 2 2 4 1 8 8

Bank 3 4 2 13 5 20 19

Bank 6 5 1 13 6 22 20

Bank 7 6 9 10 6 11 13

Bank 8 12 12 12 12 12 12

Highspeed Differential I/O per 
Bank

Bank 0 0 0 0 0 0 0

Bank 1 0 0 0 0 0 0

Bank 2 2 2 3 3 6 6

Bank 3 5 4 9 4 9 12

Bank 6 5 4 9 4 11 12

Bank 7 5 6 8 5 9 10

Bank 8 0 0 0 0 0 0

Total Single Ended/ Total 
Differential I/O per Bank

Bank 0 26/13 20/10 36/18 26/13 42/21 48/24

Bank 1 14/7 10/5 24/12 14/7 36/18 36/18

Bank 2 8/4 9/4 14/7 8/4 28/14 28/14

Bank 3 18/9 12/6 44/22 18/9 58/29 63/31

Bank 6 20/10 11/5 44/22 20/10 67/33 65/32

Bank 7 23/11 30/15 36/18 23/11 40/20 46/23

Bank 8 24/12 24/12 24/12 24/12 24/12 24/12

DDR Groups Bonded per 
Bank2

Bank 0 2 1 3 2 3 4

Bank 1 1 0 2 1 3 3

Bank 2 0 0 1 0 2 2

Bank 3 1 0 3 1 3 4

Bank 6 1 0 3 1 4 4

Bank 7 1 2 2 1 3 3

Configuration 
Bank 8 0 0 0 0 0 0

SERDES Quads 1 1 1 1 1 1

1. These pins must remain floating on the board.
2. Some DQS groups may not support DQS-12. Refer to the device pinout (.csv) file.
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Package Pinout Information
Package pinout information can be found under “Data Sheets” on the LatticeECP3 product pages on the Lattice 
website at http://www.latticesemi.com/Products/FPGAandCPLD/LatticeECP3 and in the Diamond or ispLEVER 
software tools. To create pinout information from within ispLEVER Design Planner, select Tools > Spreadsheet 
View. Then select Select File > Export and choose a type of output file. To create a pin information file from within 
Diamond select Tools > Spreadsheet View or Tools >Package View; then, select File > Export and choose a 
type of output file. See Diamond or ispLEVER Help for more information.

Thermal Management 
Thermal management is recommended as part of any sound FPGA design methodology. To assess the thermal 
characteristics of a system, Lattice specifies a maximum allowable junction temperature in all device data sheets. 
Designers must complete a thermal analysis of their specific design to ensure that the device and package do not 
exceed the junction temperature limits. Refer to the Thermal Management document to find the device/package 
specific thermal values.

For Further Information
For further information regarding Thermal Management, refer to the following:

• Thermal Management document

• TN1181, Power Consumption and Management for LatticeECP3 Devices

• Power Calculator tool included with the Diamond and ispLEVER design tools, or as a standalone download from 
www.latticesemi.com/software

http://www.latticesemi.com/Products/FPGAandCPLD/LatticeECP3.aspx
www.latticesemi.com/dynamic/view_document.cfm?document_id=210
www.latticesemi.com/dynamic/view_document.cfm?document_id=32321
http://www.latticesemi.com/products/designsoftware/index.cfm
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Date Version Section Change Summary

March 2015 2.8EA Pinout Information
All

Updated Package Pinout Information section. Changed reference to 
http://www.latticesemi.com/Products/FPGAandCPLD/LatticeECP3.

Minor style/formatting changes.

April 2014 02.7EA DC and Switching 
Characteristics

Updated LatticeECP3 Supply Current (Standby) table power numbers.

Removed speed grade -9 timing numbers in the following sections:
— Typical Building Block Function Performance
— LatticeECP3 External Switching Characteristics
— LatticeECP3 Internal Switching Characteristics
— LatticeECP3 Family Timing Adders

Ordering Information Removed ordering information for -9 speed grade devices.

March 2014 02.6EA DC and Switching 
Characteristics

Added information to the sysI/O Single-Ended DC Electrical Character-
istics section footnote.

February 2014 02.5EA DC and Switching 
Characteristics

Updated Hot Socketing Specifications table. Changed IPw to IPD in foot-
note 3.

Updated the following figures:
— Figure 3-25, sysCONFIG Port Timing
— Figure 3-27, Wake-Up Timing

Supplemental 
Information

Added technical note references.

September 2013 02.4EA DC and Switching 
Characteristics

Updated the Wake-Up Timing Diagram

Added the following figures:
— Master SPI POR Waveforms
— SPI Configuration Waveforms
— Slave SPI HOLDN Waveforms 

Added tIODISS and tIOENSS parameters in LatticeECP3 sysCONFIG 
Port Timing Specifications table.

June 2013 02.3EA Architecture sysI/O Buffer Banks text section – Updated description of “Top (Bank 0 
and Bank 1) and Bottom sysIO Buffer Pairs (Single-Ended Outputs 
Only)” for hot socketing information.

sysI/O Buffer Banks text section – Updated description of “Configuration 
Bank sysI/O Buffer Pairs (Single-Ended Outputs, Only on Shared Pins 
When Not Used by Configuration)” for PCI clamp information.

On-Chip Oscillator section – clarified the speed of the internal CMOS 
oscillator (130 MHz +/- 15%).

Architecture Overview section – Added information on the state of the 
register on power up and after configuration.

DC and Switching
Characteristics

sysI/O Recommended Operating Conditions table – Removed refer-
ence to footnote 1 from RSDS standard.

sysI/O Single-Ended DC Electrical Characteristics table – Modified foot-
note 1.

Added Oscillator Output Frequency table.

LatticeECP3 sysCONFIG Port Timing Specifications table – Updated 
min. column for tCODO parameter.

LatticeECP3 Family Timing Adders table – Description column, refer-
ences to VCCIO = 3.0V changed to 3.3V. For PPLVDS, description 
changed from emulated to True LVDS and VCCIO = 2.5V changed to 
VCCIO = 2.5V or 3.3V. 
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